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Abstract

These Application Notes describe the steps necessary for configuring Session Initiation
Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office Release
10.0 to interoperate with Claro SIP Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Claro SIP Trunking Service provides PSTN access via a SIP trunk between the enterprise and
Claro’s network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Claro is a member of the Avaya DevConnect Service Provider Program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office Release 10.0 to
interoperate with Claro SIP Trunking Service.

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office (hereafter
referred to as IP Office) 500v2 Release 10.0 and various Avaya endpoints, including Avaya
Communicator for Windows softphone and Avaya Deskphones, including SIP and H.323.

During the interoperability testing, feature test cases were executed to ensure interoperability
between Claro and IP Office.

During the interoperability testing, a VPN connection was used to connect the simulated Avaya
enterprise network to Claro’s network via the public Internet. The connection could also be done
without the use of VPN.

The Claro SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place
and receive PSTN calls via a broadband WAN connection using the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks such as analog and/or
ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “Service Provider” and “Claro” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Avaya Solution &
Interoperability Test Lab by connecting IP Office to Claro SIP Trunking Service via the public
internet, as depicted in Figure 1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing
To verify SIP trunk interoperability, the following areas were tested for compliance:
e SIP OPTIONS queries and responses.

e Incoming calls from the PSTN were routed to the DID numbers assigned by Claro.
Incoming PSTN calls were terminated to the following endpoints: Avaya 96x1 Series IP
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Deskphones (H.323), Avaya 1100 Series IP Deskphones (SIP), and Avaya
Communicator for Windows.
e Qutgoing calls to the PSTN were routed via Claro’s network to various PSTN
destinations.
e Caller ID presentation.
e Proper disconnect when the caller abandons the call before the call is answered.
Proper disconnect via normal call termination by the caller or the called parties.
Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.
Proper response/error treatment when dialing invalid PSTN numbers.
Proper Codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711MU, G.711A and G.729A, Claro’s preferred codec order).
No matching codecs.
e Proper early media transmissions.
Voicemail and DTMF tone support (leaving and retrieving voice mail messages from
PSTN phones).

e Outbound Toll-Free calls, interacting with IVR (Interactive VVoice Response systems).
e Calling number blocking (Privacy).

e Call Hold/Resume (long and short duration).

e Call Forward (unconditional, busy, no answer).

e Blind Call Transfers.

e Consultative Call Transfers.

e Station Conference.

e Mobility twinning of incoming calls to mobile phones.

e Simultaneous active calls.

e Long duration calls (over one hour).

e Proper response/error treatment to all trunks busy.

e Proper response/error treatment when disabling SIP connection.
o T.38 fax.

Note: Remote worker was not tested with this solution since the Avaya Session Border
Controller for Enterprise (Avaya SBCE) was not included in the configuration used during the
compliance testing. The Avaya SBCE is a required component for enterprises planning to deploy
Remote Workers.

Items not supported or not tested included the following:
e The SIP REFER method for call redirection was not tested for reasons noted under
Section 2.2.
e (.711 fax pass-through was not tested.
e Inbound toll-free calls, Outbound Toll-Free calls, 911 calls (emergency), “0” calls
(Operator), 0+10 digits calls (Operator Assisted), and 411 calls (Local Directory
Assistance) were not tested.
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2.2. Test Results

Interoperability testing of Claro SIP Trunking Service was completed successfully with the
following observations/limitations.

SIP REFER: Calls from the PSTN to IP Office that are re-directed to another PSTN
endpoint by the IP Office user, with REFER enabled in IP Office, did not work properly.
Testing was done with REFER disabled in IP Office, refer to Section 5.4.3.

Fax support: T.38 Fax transport did not work properly, T.38 fax is under investigation
by Claro.

Incoming calls from U.S. based PSTN numbers to IP Office did not release on the
PSTN side: Calls originating from PSTN telephones based in the U.S. to IP Office did
not release on the PSTN telephones side when calls were first released at the enterprise
(IP Office) side. The correct SIP message exchange in between IP Office and Claro was
observed, with IP Office sending “BYE” to Claro and Claro acknowledging the “BYE”
with “200 OK”. This behavior was not seen if calls were originated locally from PSTN
numbers based in Santo Domingo. Also, this behavior was not seen with outgoing calls
from IP Office to PSTN telephones based in the U.S. , it was only seen with incoming
calls from PSTN numbers based in the U.S. This issue was reported to Claro.

Incoming calls from U.S. based PSTN numbers to IP Office busy stations: Audible
busy tone to the users was delayed when calls were originated from PSTN telephones
based in the U.S. to IP Office busy stations. The correct SIP message exchange was
observed, with IP Office sending “486 Busy Here”, with Claro acknowledging with
“ACK”. It was also observed that Claro would send several INVITE messages, with IP
Office responding with “486 Busy Here” to each INVITE message, audible busy tone
was then played to the user after a period of time. This behavior was not seen if calls
were originated locally from PSTN numbers based in Santo Domingo. This issue was
reported to Claro.

Caller ID display on Call Forwards to the PSTN: For Calls from the PSTN to IP
Office, that were Forwarded back out to the PSTN, the caller ID number displayed at the
PSTN was always of the first DID number assigned to the SIP Trunk , regardless of the
PSTN number being used to originate the call.

Caller ID display on Mobile Twinning: For Mobile Twinning calls, the Caller 1D
display at the Mobile/cellular station was always of the first DID number assigned to the
SIP Trunk, regardless of the PSTN number being used to originate the call.

No matching codec on outbound calls: If an unsupported audio codec is received by
Claro on the SIP Trunk (e.g., 722-64K), Claro will respond with “500 Server Internal
Error” instead of “488 Not Acceptable Here”, and the user will hear re-order. This issue
does not have any user impact, it is listed here simply as an observation.

2.3. Support

For support on Claro systems visit the corporate Web page at:
http://www.claro.com.do/wps/portal/do/sc/empresas
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Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Claro SIP Trunking Service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
Avaya IP Office 500v2.

Avaya Voicemail Pro for IP Office.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 1100 Series SIP IP Deskphones.

Avaya Communicator for Windows Softphone.

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of IP Office is connected to the enterprise LAN (private IP network);
LANL1 port is also used to connect to Claro’s network via a VPN connection. Endpoints include
Avaya 96x1 Series IP Deskphones (with H.323 firmware), Avaya 1100 Series IP Deskphones
(with SIP firmware) and Avaya Communicator for Windows. The site also has a Windows PC
running Avaya IP Office Manager to configure and administer the IP Office system, and Avaya
Voicemail Pro providing voice messaging service to the IP Office users. Mobile Twinning is
configured for some of the IP Office users so that calls to these user’s extensions will also ring
and can be answered at the configured mobile phones.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to the PSTN via Claro’s network. The short code 9 was stripped off by IP
Office but the remaining “N” digits were sent unaltered to the network. Refer to Section 5.6.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the IP Office system, such as firewalls. A
complete discussion of the configuration of these devices is beyond the scope of these
Application Notes. However, it should be noted that all SIP and RTP traffic between the service
provider and the IP Office system must be allowed to pass through these devices.
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For confidentiality and privacy purposes, public IP addresses and DID numbers used during the
compliance testing have been masked.

Service Provider

Gateway: 190.166.214.6

' ™
Simulated Enterprise
Domain: avaya.lab.com
DIDs: 123-456-9226, 9254
Router VPN Gateway I IPSec Tunnel
Eth4: 10.64.70.53 Eth3: 10.64.120.8
LANT | 1064 7060
Avaya IP Office 500 V2.
Rel 10.0
Desktop PC
Avaya 96x1 Serles
IP Deskphones
- Avaya IP Office Manager (H.323)
- Avaya Voice Mail Pro Client Avaya 1100
- Avaya Communicator for Windows ({SIP)) Series IP
Deskiphones
Fax (S1P}
M A
Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software | Release/Version
Avaya
Avaya IP Office 500v2 10.0.0.0.0 Build 550
Avaya IP Office DIG DCPx16 V2 10.0.0.0.0 Build 550
Avaya IP Office Manager 10.0.0.0.0 Build 550
Avaya Voicemail Pro Client 10.0.0.0.0 Build 469
Avaya 96x1 Series IP Deskphones (H.323) Version 6.6229
Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00
Avaya Communicator for Windows 2.1.3.237
Claro
IMS Huawei CSCF-BCF VV100R010C00SPC100
SBC Huawei SessionEngine2600 VV200RO09ENGC30SPC100

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500v2 and also when deployed with all configurations of IP Office Server Edition.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 41
SPOC 11/10/2016 ©2016 Avaya Inc. All Rights Reserved. Claro_IPO10




5. Configure Avaya IP Office

IP Office is configured through the Avaya IP Office Manager application. From the PC running
Avaya IP Office Manager, select Start - Programs - IP Office - Manager to launch the
application. A screen that includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from System|

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File - Open Configuration at the top of the
Avaya IP Office Manager window. Select the proper IP Office system from the pop-up window
and log in with the appropriate credentials.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider is assumed to already be in place.

In the sample configuration, IP500V2 Main was used as the system name. All navigation
described in the following sections (e.g., License > SIP Trunk Channels) appears as submenus
underneath the system name IP500V2 Main in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP trunk channels license with sufficient capacity; click License in the
Navigation pane. Confirm a valid license with sufficient Instances (SIP Trunk Channels) in the

Details pane.

(=557 System (1)

*s IPS00V2 Main
4 Line (25)
[#-“=» Contrel Unit (4)
-4 Extension (48)
=g User (50)
- Group (1)

Licensed Version 10.0
PLDS Host ID
PLDS File Status ~ Valid

IP Offices £
=R BOOTP (5) License | Remote Server
(¢ Operator (3)
=[5 TP500VZ Main License Mode  License Normal

Feature Key Instances Status Expiration Date Source o

8% Short Code [68)

B Senvice 0) Mobile Worker N/A 384 Valid Never PLDS Nod:
s RAS (1) Office Worker N/A 384 Valid Mever PLDS Modz
=P Incoming Call Route (3) Avaya Softphone Licence M/A 100 Valid Never PLDS Nod:

@ WaN Port 0) VMPro TTS (Scansoft) N/A 40 Valid Never PLDS Nod:
- Directory (0) . . N
£7 Time Profile (0) VMPro TTS Professional MN/A 40 Valid Never PLDS Mod:

e @ Firewall Profile (1) IPSec Tunnelling MN/A 1 Valid MNever PLDS Nod:

-l IP Route (12) Power User MN/A 384 Valid Mever PLDS Nod:

B Account Code (0) Avaya IP endpoints MN/A 384 Valid Mever PLDS Mode

A License (20)| 1P500 Voice Networking Channels /A 2 Valid Never PLDS Nod:
8 Tunnel () [SIP Trunk Channelz N/ 2 Valid Never PLDS Nod:|

=-fg User Rights (8)

- ARS (2) IP500 Universal PRI (Additional cha... MN/A 100 Valid Mever PLDS Nod:
8@ Location (0) CTILink Pro MN/A 1 Valid Mever PLDS Mod:
ﬁ Authorization Code (0) Wave User MN/A 16 Valid MNever PLDS Mode

3rd Party IP Endpoints N/A 384 Valid MNever PLDS Mod:
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To view the physical hardware comprising IP Office, expand the components under the Control
Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500v2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An IP Office hardware configuration with a
VCM component is necessary to support SIP Trunking Services.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the Avaya IP 500 V2.

IP Offices

il

IP 500 v2

- R BOOTP (5)
+-i# Operator (3)
'i'""‘"-x- Systern (1)

-4 Line (25)
— =+ Control Unit (4]

= 2VCMB4/PRID U
= 3 PHONES
. § DIG DCPx6 V2
+-4 Extension (48)

+-§  User (50)

+ﬁ Group (1)

+-@% Short Code (68)
@ Service (0)

+I-alls RAS (1)

----- B8 WAN Port ()

----- @ Directory (0)

----- £ Time Profile (0)
+-{@ Firewall Profile (1)
+- [l IP Route (12)

----- | Account Code (0)
----- & License (89)

----- @& Tunnel (0]

43 User Rights (8)
+-g ARS (2)

----- &5 Location (0)

+¢ Incoming Call Route (3)

----- % Authorization Code (0)

Unit

Device Mumber

Unit Type

Versicn

Serial Mumber

UnitIP Address
Interconnect Mumber

Module Number

1

1P 500 W2

10.0.0.0.0 build 550

10.64.70.60

0

Control Unit

HG; Reviewed:
SPOC 11/10/2016

Solution & Interoperability Test Lab Application Notes

©2016 Avaya Inc. All Rights Reserved.

10 of 41
Claro_IPO10




5.2. System

Configure the necessary system settings. In an IP Office system, in an actual customer
deployment, when a VPN connection is not used, the LAN2 port is used to connect to the public
network, and the LANL port is used to connect to the private network. During the compliance
testing, since a VPN connection was used, the LAN1 port was used to connect to the private
network and to connect to Claro’s network, the LAN2 port was not used.

5.2.1. System — LAN1 Tab

In the sample configuration, the IP Office LAN1 port was used to connect to the enterprise
network (private network) and to Claro’s network. To access the LAN1 settings, first navigate to
System - <Name>, where <Name> is the system name assigned to IP Office. In the case of the
compliance test, the system name is IP500V2 Main. Next, navigate to the LAN1 - LAN
Settings tab in the Details pane. Set the IP Address field to a private IP address on the
enterprise LAN side (private IP network). Set the IP Mask field to the mask used on the
enterprise LAN side (private IP network). All other parameters should be set to default or
according to customer requirements. Click OK to commit (not shown).

IP Offices = IP500V2 Main

=K BOOTP (5)

: 1LaN2 | DNS Yoicemail | Telephony | Directory Services | System Events
i Operator (3) d | | | g }"l L | .

== IP500V2 Main LAN Settings |‘u‘oIP | Metwork T0pology|

+-§P Incoming Call Route (3)
----- B2 WAN Port (0)

-8 Directory (0)

----- £ Time Profile (0)

-8 Firewall Profile (1)

+- [l IP Route [12)

----- #m Account Code (0]

----- % License (89)

""" @& Tunnel ([0)

+-§q User Rights (8)

- ARS (2)

IE Location (0]

ﬂ Authorization Code (0)

Y

Murnber Of DHCP IP Addresses 200
DHCP Mode

0 Server () Chent ) Dhalln @ Disabled

—"'-x System (1)

. sy [PS00V2 Main IP Address 10 B4 70 &0
T4 Line (25)

w2 Control Unit (4) IP Mask 255 . 255 . 255 0
-4 Extension (48) )

: , 0 0 0 0
+: User (50) Primary Trans. IP Address

=-5§ Group (1) RIP Mode [None =
+-@% Short Code (68)

D Service (0) [7] Enable NAT

H-olfy RAS (1)

Advanced
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On the VoIP tab in the Details pane, configure the following parameters:

Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the
H.323 protocol to register.

Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Claro.

Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register
using the SIP protocol.

Enter the Domain Name of the enterprise under SIP Domain Name.

Enter the SIP Registrar FQDN of the enterprise under SIP Registrar FQDN.

Verify the UDP Port and TCP Port numbers under Layer 4 Protocol are set to 5060.
Verify the RTP Port Number Range settings for a specific range for the RTP traffic.
The Port Range (Minimum) and Port Range (Maximum) values were kept as default.

IP Offices IE IP500V2 Main

-7

=- R BOOTP (5)
. Operator (3)
1P500V2 Main

s

-4 Extension (48)
=g User (50)

5§ Group (1)

+“ Short Code (68) SIP Trunks Enable
ATy S, 0

+§ Rir;n(cle)( ) SIP Registrar Enable

+@ Inceming Call Route (3)
-§8 WAN Port (0)

' T
"@F

El IF Route (12)

| system| LAML |Lan2 | DNS | Voicemail | Telephony | Directory Services | System Events | smTp | sMDR [vem [ volp | velp Security

| LAM Settiﬂgslé VelP I Metwork Topology|

' IPS00V2 Main
Line (25)
Control Unit (4)

| H.323 Gatekeeper Enablel
[7] Auto-create Extension

Auto-create User H.323 Remote Extension Enable

H.323 Signaling over TLS Disabled - Remote Call Signaling Port 1720

[T Auto-create Extension/User SIP Remote Extension Enable

SIP Domain Mame avaya.lab.com

irewall Profile (1) SIP Registrar FQDM avaya.lab.com

Account Code (0) upp UDP Port 5060 = Rermote UDP Port 5080 =
= License (89)
i Tunnel (0) Layer 4 Protocol TCP TCP Port 5060 = Remote TCP Port (5060 =
#-§i3 User Rights (8) = -
+§K' ARS (2)9 LS TLS Port  |S061 : Remote TLS Port (5061 :
E Location (0} —
m Authorization Code (0) Challenge Expiration Time (sec) 10 =
RTP

Port Mumber Range

Minirmum 49152 = Maximum 53246 =

Port Mumber Range (MAT)

Minirmum 49152 = Maximum 53246 =

HG; Reviewed:
SPOC 11/10/2016

Solution & Interoperability Test Lab Application Notes

©2016 Avaya Inc. All Rights Reserved.

12 of 41
Claro_IPO10



Scroll down the page.

In the RTP Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout
to 30 and the Initial keepalives parameter to Enabled. These settings will cause IP
Office to send a RTP keepalive packet starting at the time of initial connection and every
30 seconds thereafter if no other RTP traffic is present. This facilitates the flow of media
in cases where each end of the connection is waiting to see media from the other, as well
as helping to keep firewall ports open for the duration of the call.

In the DiffServ Settings section, IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

All other parameters should be set to default or according to customer requirements.
Click OK to commit (not shown).

IP Offices |Ei IP500V2 Main*

=-R BOOTP (5)
#-{# Operator (3)

| system | LANL | LAN2 [DNS [ Voicemail | Telephony | Directory Services | System Events | sMTP | smDR | vem | valP | velP Security

TP500V2 Main LAN Settings| VolP | Network Topology |
Systern (1)
=9 IP500V2 Main
4 Line (25) Port Mumber Range (NAT)
+-“= Control Unit (4) ini 49152 = i 53246 =
44 Bxtension (48) Minimum = Maximurn
+-§  User (50)
+1ﬂ Group (1) V| Enable RTCP Maonitoring on Port 5005
+-@% Short Code (68)
4B Service (0) RTCP collector IP address for phones 0 0 0
+1- oy RAS (1) .
+e Incoming Call Route (3) Keepalives
£ WAN Port (0) Scope |RTP-RT(P v| Periodic timeout 30
@m Directory (0)
('W Time Profile (0) Initial keepalives |Enabled - |
#1- @) Firewall Profile (1)
+n IP Route (12)
- Account Code ()
% License (89) ) )
¥ Tunnel (0) DiffServ Settings
: §5 User Rights (8) B& *| DSCP{Hex) B3 > Video DSCP (Hex) FC +| DSCP Mask (Hex) 88 T SIG DSCP (Hex)
- ARS (2)
i Location (0) 46 2] pscp 46 2] videoDSCP 63 [Z] DSCP Mask 4 [ siGpsce
ﬂ Authorization Code (0]
DHCP Settings
Primary Site Specific Option Nurmber (4600,/5600) 176 =
Secondary Site Specific Option Number (1600/9600) 242 T
VLAN Mot Present -
1100 Voice VLAM Site Specific Option Mumber (S50M) 232 =
1100 Voice VLAN IDs
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between IP Office and Claro, the parameter was set to Open Internet.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the
frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which IP Office will listen.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices = IP500V2 Main

#-R BOOTP (5) | system | LANL |Lanz [DNS | Voicemail | Telephany | Directory Services | System Events | sMTP | SMDR [vem [ velP | VolP Security

#-4+ Operator (3)
[ 1P500V2 Main | LaN Settings | vorr | NetworkTopo\ogyl

Systern (1)
= [P500V2 Main MNetwork Topology Discovery

=1 Line (25) STUN Server Address £9.90.168.13 STUN Port 3478 =
f-+2 Control Unit (4)
- Extension (48) Firewall/NAT Type | Open Internet - |
i-§  User (50)
3§ Group (1) Binding Refresh Time (sec) 300 <
8% Short Code (68) —————
@ Service () PublicIP Address 0 0 0 0 Run 5TUN Cancel
oy RAS (1)
. e Incoming Call Route (3) Public Port

§8 WAN Port (D) =

== Directory (0) uop 060 i

Time Profile ([0) =

&) Firewall Profile (1) Tce 3050 =z
- Jill IP Route (12) Tis 5061 =
-l Account Code (0)

% License (89) Run STUN on startup
i Tunnel (0)
#-§5 User Rights (8)
- ARS (2)

EE Location (0)
ﬂ Authorization Code (0)

Note: In the compliance test, the LAN1 interface was used to connect IP Office to the enterprise
private network (LAN) and to Claro’s network across the VPN connection, LAN2 was not used.
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5.2.2. System - Telephony Tab
Navigate to the Telephony = Telephony tab in the Details Pane, configure the following
parameters:
e Choose the Companding Law typical for the enterprise location, U-Law was used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and

call transfers to the PSTN via the SIP trunk to the service provider.

e All other parameters should be set according to customer requirements.
e Click OK to commit (not shown).

IP Offices = IP500V2 Main 5
B8 poor® ‘5(33) System | LANL [LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events [ sMTP | SMDR [veM [ velP | velP Security | Contact Center
b perator

%= Systemn (1)

1P500V2 Main

--¥p [P500V2 Main

-4 Line (25)

<= Control Unit (4)
-4 Extension (48)

@ User (50)

i3 Group (1)

@ Short Code (68)
@ Service (0}

oy RAS (1)

@ Incoming Call Route (3)
~E WAN Port (0
-4 Directory (0)
~£17 Time Profile (0)
@ Firewall Profile (1)
-ill IP Route (12)
-l Account Code (0}
W License (89)

- i Tunnel (0}

B3 User Rights (3)
¥ ARS (2)

@ Location (0)

m Authorization Code (0]

Telepheny | Park & Pagel Tones & Musicl Ring Tones | SM

[ callog [ TUr |

Analogue Extensions

Default Qutside Call Sequence
Default Inside Call Sequence
Default Ring Back Sequence

Restrict Analogue Extension Ringer Voltage

=

Dial Delay Time (sec)

]| 4]

=}

Dial Delay Count

Default Mo Answer Time (sec) 15

Hold Timeout (sec) 0 =
Park Timeout (sec) 300 =
3 —

Ring Delay (sec)
Call Priority Promotion Time (sec) |Disabled
Default Currency usD
Default Name Pricrity Favor Trunk
Media Connection Preservation Disabled
Phone Failback

Legin Code Complexity
[C] Enforcement

Complexity

RTCP Collector Configuration
[] Send RTCP to an RTCP Collector

5005

Ring Type 1 hd
Ring Type 2 -

]

Cornpanding Law

Switch Line

@ U-Law @ U-Law Line

) A-Law () A-Law Line
[ DSS Status
Auto Hold

Dial By Name

Show Account Code

||:| Inhibit Off-Switch Forward/Transfer

[ Restrict Network Interconnect
Include location specific information
[7] Drop External Only Impromptu Conference

[7] Visually Differentiate External Call

[] Unsupervised Analog Trunk Disconnect Handling

High Quality Conferencing
Digital/Analogue Auto Create User
|| Directory Overrides Barring

[T Advertise Callee State To Internal Callers
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5.2.3. System — VoIP Tab

For Codecs settings, navigate to the System (1) = IP500V2 Main->VolP tab in the Navigation
pane, select the Codecs tab and configure the following parameters:
e Inthe Codecs tab of the Details pane, select or enter 101 for RFC2833 Default Payload.
This setting was recommended by Claro for use with out-band DTMF tone transmissions.
e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP phones (SIP and H.323) will use
the system default codec selection shown here, unless configured otherwise for a specific
extension. The example below shows the codecs used for IP phones (SIP and H.323), the
system’s default codecs and order was used.

IP Offices | E IP500V2 Main |

=K BOOTP (5)
H--4# Operator (3)
P500V2 Main
= System (1)
=7 IP500V2 Main

| system [ Lan1 [LaN2 [ DNS | Voicemail | Telephony | Directory Services | System Events [ smte [ smpr |vem | Volp [l

Ignore DTMF Mismatch For Phones

Allow Direct Media Within NAT Location

T Line (25)

#-= Control Unit (4) |RFC2833 Default Payload 101 =

-4 Extension (48)

+: User (50} Available Codecs Default Codec Selection

+ﬂ Group (1) Unused Selected

¥ Short Code (68) 9] G.711 ULAW 64K 6.722 64K sax || [GI11 ULAW 64K
E:@ ;Z’;‘"e(m 7] G.711 ALAW 64K G.711 ALAW 64K

i %1 @ CallRoute ) 7] 6.722 64K (.729() 8K CS-ACELP
7\ ncoming Lall Route V| .729(a) 8K CS-ACELP 5.723.1 6K3 MP-MLI
8 WAN Port (0) @ Q

¥| G.723.1 6K3 MP-MLQ

t-5 User Rights (8)
- ARS (2)
""" & Location (0)

e ﬂ Authorization Code (0)

Note: The codec selections defined under this section (System — Codecs Tab) are the codecs
selected for the IP phones/extensions. The codec selections defined under Section 5.4.6 (SIP
Line — VolIP tab) are the codecs selected for the SIP Line (Trunk).
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5.3. IP Route

Create an IP route to specify the IP address of the gateway or router where IP Office needs to
send the packets in order to route calls to Claro’s network (if located in a different IP subnet).

In the reference configuration, the IP Office LANL1 interface and the interface of the VPN
gateway resided in different IP subnets, so an IP route was necessary to specify the IP address of
the gateway or router where IP Office needs to send the packets, in order to reach the IP subnet
where the VPN gateway resides.

To create an IP route to specify the IP address of the gateway or router where the IP Office needs
to send the packets in order to reach the IP subnet where the VPN gateway resides (if located in
different IP subnets), on the left navigation pane, right-click on IP Route and select New.

e Set IP Address to 172.31.21.0 (IP subnet assigned to Claro’s SIP Proxy).

e Set the IP Mask to 255.255.255.0 (IP Mask assigned to Claro’s SIP Proxy).

e Set Gateway IP Address to the IP address of the router where IP Office is connected.
Gateway IP Address 10.64.70.53 was used in the sample configuration, which correspond
to the IP address assigned of the router used to route calls to the VPN gateway. Refer to
Figure 1.

e Set Destination to LAN1 from the drop-down list.

e Click the OK to commit (not shown).

IP Offices IE 172.31.21.0

+a BOOTP (5) IP Route

+-i7 Operator (3)
= [ 1P500V2 Main IP Address 172 31 21 0

5% System (1) 1P Mask 255 . 255 . 255 0

¢ sy IPS00V2 Main

~ 19 Line (23) Gateway IP Address 10 64 70 53
= Control Unit (4)

-y Extension (48) Destination LANL

+
2
:
:

i@ User (50)
+,ﬂ Group (1) Metric 0
+-@% Short Code (68)

@B Service (0)

+e Incoming Call Route (3)
-8 WAN Port (0)

-4 [hrectory (0]

-7 Time Profile (0)

2@ Firewall Profile (1)
Bl TP Route (12)]
-ill 108.240.86.34

-l 172.16.5.0

-l Account Code (0)
W License (89)

il Tunnel (0)

i1-§q User Rights (8)

+- g ARS (2)

E'T? Location (0)

ﬁ Authorization Cede (0)

Proxy ARP
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5.4. SIP Line

A SIP Line is needed to establish the SIP connection between IP Office and Claro SIP Trunking
Service. The recommended method for configuring a SIP Line is to use the template associated
with these Application Notes. The template is an .xml file that can be used by Avaya IP Office
Manager to create a SIP Line. Follow the steps in Sections 5.4.1 and 5.4.2 to create the SIP Line
from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP trunk Registration Credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.3 t0 5.4.7.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.4.3
to 5.4.7

5.4.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format. These
XML templates do not include sensitive customer specific information and are therefore suitable
for distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500v2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., C:\Temp) on the same computer
where IP Office Manager is installed. By default, the template file name will have the format
<user supplied text>.xml, where the <user supplied text> portion is entered during template
file creation.

Note — If necessary, the <user supplied text> portion of the template file name may be
modified, however the <user supplied text>.xml format of the file name must be maintained.
For example, an original template file TEST.xml could be changed to Test1l.xml. The template
file name is selected in Section 5.4.2, Step 1, to create a new SIP Line.
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2. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager.

f Avaya IP Office Manager IP500Y2 Main [10.0.0.0.0 build 550] [Admin

File  Edit View Tn:n:nlslHeIp

2 E-H SIE Extenszion Renumber...

IP500Y2 Main Line Renumber...
Connect Tao...
IP Offic
Export

=R BOOTP (5)
#-i% Operator (3)

SCM Service User Management

=520 IP500VZ Main Busy on Held Validation
=537 System (1)
P ey IPSOOV2 MSM Cenfiguration
T:f Line (25) Print Button Labels
[F-=% Control Unit .
@ Extension (4 Imnport Templates in Manager
a User (50] License Migration
ﬂ Group (1) ” =

3. A folder browser will open. Select the directory used in Step 1 to store the template(s) (e.g.,

C:\Temp).
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In the reference configuration, template files Claro_IPO10.xml was imported. The template
files are automatically copied into the IP Office default template location, C:\Program
Files\Avaya\lP Office\Manager\Templates.

4. After the import is complete, a final import status pop-up window will open stating success
or failure. Click OK.

P -

Template Provisicning @

g 1 Successfully imported temnplates to IP Office Manager from
' ChTemnp

5.4.2. Creating a SIP Trunk from an XML Template

1. To create the SIP Trunk from a template, right-click on Line in the Navigation pane, and
select New SIP from Template and select the template on the right hand side, in this case
Claro_IPO10.xml was selected

IP Offices =
=& BOOTP (5) + || SIP Line Transport | SIP URI| VoIP | T38 Fax|SIP Credentials|SIP
4% Operator (3)
EI---"-;.J IP500%2 Main Line Mumber 17 =
TN New »
& Cut Crl+X
53 Copy Ctrl+C
sIP
Paste Ctrl+V ’
7< Delete Ctrl+Del |Cloud
+  Validate
Connect To.. Ctrl+T
----- Mew from Template r I ClareIlPO105BC71.Ine
""" ? Export az Temnplate Claro_IPO10.xml I]
..... i .
_____ ?% ;gi = International Prefix Open from file
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After the import is complete, a final import status pop-up window will open stating success or

failure. Click OK

-

Template Provisioning

S5

:I Mew SIP Trunk created successfully using selected template.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

IP Offices

-

- & BOOTP (5)
[ Operator (3)

=520 IPS00Y2 Main
apese] System (1)
=-T7 Line (25)

[

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.4.3 t0 5.4.7.
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5.4.3. SIP Line = SIP Line Tab
On the SIP Line tab in the Details pane, configure or verify the parameters as shown below.

e Leave the ITSP Domain Name blank. Note that if this field is left blank, IP Office
inserts the far end's ITSP Proxy Address from the Transport tab as the ITSP Domain in
the SIP messaging.

e Verify that URI Type is set to SIP.

e Verify that In Service box is checked, which is the default value. This makes the trunk
available to incoming and outgoing calls.

e Verify that Check OOS hox is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line. The time between SIP OPTIONS
sent by IP Office will use the Binding Refresh Time for LAN1, as shown in Section
5.2.1.

o Verify that Refresh Method is set to Auto.

e Verify that Timer (seconds) is set to On Demand.

e Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing
Supervised REFER to Never (Refer to Sections 2.1 and 2.2).

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices ‘ = SIP Line - Line 17 e - X
:i" E]OOTE (5]3 ~ ||5IP Line hransportlSIP URIIVDIP |T38 FaxlSIP Credent\a\slSIP AdvancedlEngmeenng‘
i' Line Number 17 — In Service v
i'rd E.:EE(?S)J |rrsp Domain Name | Check 005 v

: é Local Demain Name

- 18 |URITypa ‘S[P -|| Session Timers

: ég Location ‘C\nud v| Refresh Method Auto -

iy, 71 Timer (sec) On Demand =

gy, 22

gy, 23

14 201 Prefix

‘H 203 Matienal Prefix 0

E o || mtemational et w0

{j 206 Country Code Redirect and Transfer

1:4: gg; Name Priority System Default - Incoming Supervised REFER ‘Never "

¥11 ggg Description Service Provider Outgoing Supervised REFER ‘NEVW "

-7 211 Send 302 Moved Tempaorarily

E = Outgoing Blind REFER

(e Control Unit (4)

+-4 Extension (48)

#-§  User (30)

-5 Group (1)

+-@% Short Code (68)

@ Service (1)

:“% Iﬂliign Call Route (3)

g WAN o o

P Directory (0)

ke T.\meProfMe(Oj —

2 e =
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 22 of 41

SPOC 11/10/2016 ©2016 Avaya Inc. All Rights Reserved. Claro_IPO10



5.4.4. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.
e Set ITSP Proxy Address to 172.31.21.1, the IP address of Claro’s SIP Proxy.
e Set Layer 4 Protocol to UDP.
e Set Use Network Topology Info to None.
e Setthe Send Port and Listening Port to 5060.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

IP Offices ‘ i= SIP Line - Line 17

@R BOOTP (5) * | |stp Line| Transport|stp URI|VolP  |T38 Fax|SIP Credentials|SIP Advanced|Engineering|

4% Operator (3)
=% TP500VZ Main | ITSP Proxy Address 17231211 |

(-0 Systern (1)

E|[_‘ Line§25 i - .
™ 1 Metwork Configuration

2 Layer 4 Protocal ’UDP VI Send Port 5060 2

Use Network Topology Info lNone VI Listen Port 5060

4

8
9
S Explicit DNS Server(s) 0 0 0 0 0 0 0 0
2 Calls Route via Registrar

Separate Registrar

H-+<2r Control Unit (4)
t-4 Extension (48)
H-§  User (50)

-8 Group (1)

o @ Short Code (58)
4B Service (0)
E-ally RAS (1)

- Incoming Call Route (3)
- E8 WAN Port (0)
a4 Directory (0]
£ Time Profile (0)

e O e O pr O s O P

G- @8 Firewall Profile (1)

=-J§ll IP Route (12) i
Ready
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5.4.5. SIP Line - SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept
on this line. Select the SIP URI tab, and then click the Add... button and the New Channel area
will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the
top, and click the Edit... button. In the example screen below, a previously configured entry was
edited. For the compliance test, a single SIP URI entry was created that matched any DID
number assigned to an IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name to Use Internal Data.

e Set Header under Identity to P Asserted ID.

e Set Send Caller ID under Forwarding and Twinning to Diversion Header

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and

outgoing group 17 was defined that only contains this line (line 17).

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern. This field should be set according to customer requirements; in the sample

configuration the value of 10 was used.
e Click OK to commit.
e Click OK to commit again (not shown).

IP Offices | = SIP Line - Line 17°
=R BOOTP (5) |SIP LlnelTransport| SIP URI |VDIP |T38 FaxlSIP Credentlal;lSIP AdvancedlEﬂglneermg|
E-{# Operator (3
= 500V2 Main URI Groups Local URI  Contact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls
— system (1) 1 17 17 <Internal> <Internal> <Internal> MNone PAT Diversion 0: <Non... 10
T4 Line (25)
o 1
oo 3
T
: ;g Edit URI
T4 201 Local URL Use Internal Data -
-4 202
-F1 203 Contact Use Internal Data -
-9 204
-7 205 Display Name Use Internal Data -
! Identi
1 200 &
-4 208 Identity Mone -
T4 209
-7 210 Header P Asserted ID -
-4 211
-7 212 Forwarding And Twinning
-7 213 Originator
-7 214 Number
-4 215 .
-4 216 send Caller [D Diversion Header -
-2 Control Unit (4) 1
A Extension (48)
@ User (30)
iR Group (1)
--B% Short Code (58) Diversion Header Mone -
B Service (0
E Ri';"a?( ) Registration 0: <None> v
e Incoming Call Route (3) I ing G 17 -
) WAN Port (0] ncoming Group
- Directory (0) Outgoing Group 17 -
77 Time Profile (0)
@ Firewall Profile (1) Max Sessions 10 -
A 1P Route (12)
m Authorization Code (0)
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5.4.6. SIP Line - VoIP Tab

Select the VoI P tab, to set the VVoice over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below.

e In the sample configuration, the Codec Selection was configured using the Custom
option, allowing an explicit order of codecs to be specified for the SIP Line. The buttons
allow setting the specific order of preference for the codecs to be used on the SIP Line, as
shown. Codec’s G.711ULAW, G.711ALAW and G.729(a) were selected for audio.

e Select None for Fax Transport Support (Refer to Sections 2.1 and 2.2).

e Set the DTMF Support field to RFC2833. This directs IP Office to send DTMF tones
using RTP events messages as defined in RFC2833.

e Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on
the trunk.

e Check the PRACK/100rel Supported box, to advertise the support for reliable
provisional responses and Early Media to Claro.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices | = SIP Line - Line 17
#- R BOOTP (3)

|S[P L|ne|Transport|S[P URIIVDIP |T38 FaxlSIP Credent\al;lSIP AdvancedlEngmeerlng‘

[T] VelP Silence Suppression

3) Syst
i.I)Fi Li;:i;ﬂsii) [7] Local Hold Music
:é Codec Selection ICU5t°"ﬂ h | Re-invite Supported

u d Selected
1™ 17 nuse et [] Codec Lockdown
G.722 64K ey G.711 ULAW 64K

e, 18
", 19 G.7231 6K3 MP-MLQ G711 ALAW 64K [C] Allow Direct Media Path
", 20 G.729(a) 8K CS-ACELP

Force direct media with phones

g, 22 PRACK/100rel Supported

G.711 Fax ECAN

T4
-7 202
-7 203

T4 204
-7 205 PN
-7 206
BT

I;: ;g; Fax Transport Support INone .]
-7 209
-7 210
-7 211

T4 212

DTMF Support [RFcazz -

Media Security [Disabled -

#-+2 Control Unit (4)
+¢ Extension (48)
#-§  User (50)

-5 Group (1)

+-@% Short Code [68)
B Service (0)

ol RAS (1)

o Q Incoming Call Route (3)
; WAN Port [0)

am Directory (0)
617 Time Profile (0)
418 Firewall Profile (1)
- Jill IP Route (12)

; Account Code (0]
= License (89)
Tunnel (0}

3 User Rights (8)
£ ARS (2)
i Location (0)
: ﬂ Authorization Code (0]
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Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs
selected for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System —
Codec tab) are the codecs selected for the IP phones/extension (H.323 and SIP).

5.4.7. SIP Line — SIP Advanced Tab

Select the SIP Advanced tab. For outbound calls with privacy enabled, Avaya IP Office will
replace the calling party number in the From and Contact headers of the SIP INVITE message
with “anonymous”. IP Office can be configured to use the P-Preferred-ldentity (PPI) or P-
Asserted-Identity (PAI) header to pass the actual calling party information for authentication and
billing purposes. By default, IP Office will use the PPl header for privacy. To configure IP
Office to use the PAI header for privacy calls:

e Check the box for Use PAI for Privacy.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices

—

= SIP Line - Line 17

=SC IR AR

=R BOOTP (5)
445 Qperator (3)
- S P50 Merr]
=2 System (1)
-5 1P500V2 Main

= IT? Line (25]|

——

»

m

1204
-7 205
47 206

1 207

T4 208
1% 200
4% 210
421
% 212
1% 213
1214
-1 25
1% 216
&< Control Unit (4)
B4 Extension (48)
-f User (50)
-5 Group (1)
E--8% Short Code (68)
@ Service (0)

oy RAS (1)
= e Incoming Call Route (3)
~§@ WAN Port (0)
-5 Directory (0]
£ Time Profile (0)
+--@ Firewall Profile (1) =

‘SIP LinalTranspnrtlSIP URIlVoIP |T38 FaxlSIP Cradential;l SIP Advanced |Engineenng|

Addressing

Association Method |By Source IP address

Call Routing Method

Request URT -

Suppress DNS SRV Lookups

Identity

Use "phone-context”

Add user=phone

Use + for International

Use PAIfor Privacy v
Use Domain for PAI

Swap From and PAl/Diversion

Caller ID from From header
Send From In Clear
Cache Auth Credentials v

User-Agent and Server Headers

Send Location Info

MNewer -

Media

Allow Empty INVITE
Send Empty re-INVITE
Allow To Tag Change

P-Early-Media Support None -
Send SilenceSupp=0ff

Media thnne(tmn Disabled -
Preservation

Indicate HOLD

Call Control

Call Initiation Timeout (s) 4

Call Queuing Timeout (mins) |3

Service Busy Response ‘486 - Busy Here

on No User Responding Send ‘408-Request Timeout

Action on CAC Location Limit ‘Allnw\lmcama\\

Suppress Q850 Reasan
Header

Emulate NOTIFY for REFER
Mo REFER if using Diversion
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5.5. Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
Line defined in Section 5.4. To configure these settings, first navigate to User > Name in the
Navigation pane where Name is the name of the user to be modified. In the example below, the
name of the user is H323 ext 1502. Select the SIP tab in the Details pane. The values entered for
the SIP Name allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP Line (see Section 5.4.5). The SIP Name and Contact
are set to one of the DID numbers assigned to the enterprise by Claro. Note that a “+” sign was
added at the beginning of the DID number for each user under SIP Name and Contact. Claro
supports the E.164 numbering format, Claro’s network adds a “+” sign to the numbers it includes
in SIP messages it sends to the enterprise, IP Office also adds the “+” sign to the numbers in SIP
messages it sends to Claro. The SIP Display Name (Alias) parameter can optionally be
configured with a descriptive name. If all calls involving this user and a SIP Line should be
considered private, then the Anonymous box may be checked to withhold the user’s information
from the network. This can also be accomplished by activating Withhold Number on H.323
Deskphones (not shown). Click the OK to commit (not shown).

IP Offices = H323 ext 1502: 1502°

+a BOOTP (3) i DialIn | Voice Recording | Button Pregramming | Menu Programming | Mebility | Group Membership Announcements

3]

: “ Qperator (3
= 1P500V2 Main
| L.y [PSO0VZ Main

-7 Line (25)
H-<=» Control Unit (4)

g 8

I MNoUser
Im RemoteManager

1101 ExtnllOlch

1542 H323 ext 1542
w1541 H323 extl 541
w1540 1P H323 1540

SIP Mame

SIP Display MName (Alias)

Contact

+11234569226

H323 ext 1502

+11234569226

Ancnymous

..... w1501 IP H323 9640
----- g™ 1552 Rem_W SIP 1552
----- I= 1570 sipl570

5.6. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.6.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation pane
and select New. The screen below shows the short code 9N created (note that the semi-colon is
not used here). In this case, when the IP Office user dials 9 plus any number N, instead of being
directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is
configurable via ARS.
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e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Set the Line Group ID to 50: Main to be directed to Line Group 50: Main, which is
configurable via ARS.

e Setthe Locale as required, United States (US English) was used for the testing.

e Click the OK to commit (not shown).

x

IP Offices = 9N: Dial
----- o =42 » || Short Code
..... “ x43
""" 2 ~44 Code M
----- B “45* N2
----- B 45 Feature Dial
..... “ x4?
..... g *48 Telephone Mumber N
:: x;g Line Group ID 50: Main
""" 8 51 Locale | United States (US English)
..... “ x52
----- B *53*NE Force Account Code [
""" 9 *35 Force Authorization Code [
----- B *57 N2
..... “ BN.
----- 8% FNEDD
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The following screen shows a sample ARS configuration for the route Main. Note the sequence
of X’s used in the Code column of the entries to specify the exact number of digits to be
expected, following the access code and the first set of digits on the string. This type of setting
results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation pane and
click Add.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to 1N. The value N represents the additional number of digits
dialed by the user after dialing 1 (The 9 will be stripped off).
e Setthe Line Group ID to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.
e Set Locale as required, United States (US English) was used for the testing.
e Click OK to commit.

Edit Short Code
Code TXOOOOCO00X
Feature Diial -
Cancel
Telephone Mumber 1N
Line Group 1D 17 -
Locale United States (UUS Engish) |

Force Account Code
Force Authorization Code

ey 2

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The example highlighted below shows that for calls in the North American numbering plan, the
user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). The 9 is stripped off, the
remaining digits, including the 1, are included in the SIP INVITE message IP Office sends to

Claro.

IP Offices = Main el -4
=R BOOTP (3) ARS
[#-4#% Operator (3)
=% IP500V2 Main ARS Route ID 50 Secondary Dial tone

=539 System (1)
*-g IP500V2 Mai
) o Route Mame Main [Sy:tEmTone -

-F% Line (25)

= Control Unit (4)
-4 Extension (48)
@ User (50)
- Group (1)
-~@% Short Code (68)

9 Service (0)

ol RAS (1)

@ Incoming Call Route (3)
g WAN Port (0)

@ Directory (0)
£ Time Profile (0)
@ Firewall Profile (1)
-l 1P Route (12)
-8l Account Code (0)
W License (89)

- Tunnel (0)

-

- 50: Main
" 51 Outbound Fax
- Location (0)

N Authorization Code (0)

Dial Delay Time System Default (4) Check User Call Barring
Description
In Service Qut of Service Route [<None> v]
Time Profile <None> et Qut of Hours Route [<None> ']
Code Telephone Number Feature Line Group ID i
11XX 11N Dial 17
16X 16M Dial 17 —
|1XXX)GUGGOG( 1N Dial 17 |i|
DOCOCOX M Dial 17 b
411 411 Dial 23
611 611 Dial 17
GO0 6N Dial 17 4

4

T

30

—— A |ternate Route

<None>
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5.7. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system. In a scenario like the one used for the
compliance test, only one incoming route is needed, which allows any incoming number arriving
on the SIP trunk to reach any predefined extension in IP Office. The routing decision for the call
is based on the parameters previously configured for Call Routing Method and SIP URI
(Section 5.4.5) and the users SIP Name and Contact, already populated with the assigned Claro

DID numbers (Section 5.5).

5.7.1. Incoming Call Route — Standard Tab

To create an incoming call route, right-click Incoming Call Routes in the Navigation pane and

select New.

On the Standard tab of the Details pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.

e Default values can be used for all other fields.

IP Offices

"

17

+-#& BOOQTP (5)
+-¢4 Operator (3
{52 IP500V2 Main |
—Lt Systern (1)
i sy [PSO0V2 Main
-4 Line (25)
= Control Unit (4)
-4 Extension (48)
i@  User (50)
+ﬁ Group (1)
+ll Short Code (68)
-~ Service (0)
i RAS (1)

+
+
+
:

@ Inceming Call Route (3)

. e
0

B0

b e ]
----- € WAN Port (0)
----- @z Directory (0]
----- £ Time Profile (0)
+@ Firewall Profile (1)
+-Jfll IP Route (12)
----- #m Account Code (0)
----- %= License (89)
----- % Tunnel (0)
+§ 3 User Rights (8)
i ARS (2)
----- &5 Location (0)
----- % Authorization Code (D)

Standard |Voice Recording | Destinations|

Bearer Capability

Line Group ID

Iﬁm},r Voice

17

Inceming Number
Incoming Sub Address
Inceming CLI

Locale

Priority

Tag

Hold Music Source

Ring Tene Owverride

[

Il - Low

IS},rstem Source

Mone
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5.7.2. Incoming Call Route — Destinations Tab

e Under the Destinations tab, enter “.” for the Default Value. This setting will allow the
call to be routed to any destination with a value on its SIP Name field, entered on the
SIP tab of that User, which matches the number present on the user part of the incoming
Request URI.

e Click OK to commit (not shown)

IP Offices IE 17

| Standard | Voice Recording | Destinations

TimeProfile Destination Fallback Extension

3 |Defau|t\|'a|ue I | |v"

-2 Control Unit (4)
-4 Extension (48)
- User (50)

- Group (1)
-8 Short Code (68)
(B Service (0)

----- = Directory (0)

£ Time Profile (0)

5 @ Firewall Profile (1)
+-ill IP Route (12)

..... B Account Code (0)
----- W License (89)

----- % Tunnel (0)

+-§ User Rights (8)
- ARS (2)

i@ Location (0)

-8 Authorization Code (0)
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5.8. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

HG; Reviewed:
SPOC 11/10/2016
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Save Configuration

IP Office Settings

IPS00V2 Main

Configuration Reboot Mode

@ Merge
Immediate
When Free
Tirmed

Reboot Time

15:42

Call Barring
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6. Claro SIP Trunking Service Configuration

To use Claro’s SIP Trunking Services, a customer must request the service from Claro using the
established sales processes. The process can be started by contacting Claro via the corporate web
site at: http://www.claro.com.do/wps/portal/do/sc/empresas and requesting information.

During the signup process, Claro and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to Claro’s network. Claro will
provide IP addresses, Direct Inward Dialed (DID) numbers to be assigned to the enterprise, etc.
This information is used to complete the Avaya IP Office configuration discussed in the previous
sections.

Claro is responsible for the configuration of Claro SIP Trunking Service. The customer will need
to provide the public IP address used to reach IP Office at the enterprise.

During the interoperability testing, a VPN connection was used to connect the simulated
enterprise site to Claro’s network via the public Internet. The connection could also be done
without the use of a VPN connection.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. Avaya IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections.
Launch the application from Start - Programs - IP Office = System Status on the PC
where Avaya IP Office System Status is installed, log in with the proper credentials.

AVAyA IP Office System Status

Help Exit About

Online  offine

Logon

Control Unit IP Address: BIE:T R R4

Services Base TCP Port: ELELE]

=D T [ Administrator

M Auto reconnect

[l Secure connection Logon
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Select the SIP Line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

SIP Trunk Summary
Line Service State: In Service
Peer Domain Name: sipyff172.31.21.1
Resolved Address: 172.31.21.1
Line Mumber: 17
Number of Administered Channels: 10
MNumber of Channels in Use: 0
Administered Compression: G711 Mu, GT11 A, GF29 A
Enable Faststart: Off
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . -~
SIP Trunk Channel Licenses in Use: 0
SIP Device Features: UFDATE (Incoming and Outgoing)
.. Time in Remote C... Con... Caller Other Dire... Round Rec... Rec... Tran...
State  Media... ID o... Partyon... Trip ...
1 Ide [04:5...
2 Ide |04:5...
3 Ide |4da...
4 Ide |4da...
5 Ide [4da...
6 Ide [4da...
7 Ide |4da...
a8 Ide |4da...
q Ide |4da...
10 Ide [4da...
Trace [ Trace All ] [ Pause ] [ PFing ] Call Details Graceful Shutdown ] [ Force Qut of Service

Print... ” Save As... ]
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Select the Alarms tab and verify that no alarms are active on the SIP Line.

IP Office System Status

Status  Utilization Summary Alarms

Alarms for Line: 17 SIP sip://172.31.21.1

Last Date Of Error Occurrences Error Description

»
Line: 18
Line: 19

Line: 20
Line: 21

Clear Clear all Graceful Shutdown l [ Force Out of Service Print... Save As...
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7.2. Avaya IP Office Sys Monitor

The Avaya IP Office Sys Monitor application can be used to monitor and troubleshoot
signaling messaging on the SIP trunk. Launch the application from Start > Programs - IP
Office > Monitor on the PC where Avaya IP Office Sys Monitor was installed. Click the Select
Unit icon on the taskbar and select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wiew Fikers Status Help

S8 »lE[T| X[)

G| e

' ¢

K

Start/Stop Trace Select
Trace Options  Unit
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Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings — [
T1 | WPN | Wb | SCN | Jade |
&TM | cal | DTE | ECont | FrameRelay | GOD | H323 | Intedace |
SO ] Fey/Lamp l Directaom ] Media ] FFF l Rz l Routing l Semvices Systeml
Ewvents
¥ Sip Voo = [~ STUN [~ SIP Dect
|
|I "
| |
Fackets
|
| [~ SIF Rea/Opt Ax [~ SIP KMisc Rx
| [~ SIP Reg/Opt Tx [ SIP Misc Tx
||
[~ SIPCallRx [~ Cn Motify Rx
| [~ SIPCall T [ Cr Matify Tx
v Sip Bx I Filker [inmn.nnn. nine. nine)
M Sip Tx |
|
Default All | Clear All | Tab Clear Al | Tab Set &l | Cancel
SaveFle | LoadFie | LoadParialFie| SelectFie |

——— o~
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8. Conclusion

These Application Notes describe the configuration steps necessary for configuring Session
Initiation Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office
Release 10.0 to interoperate with Claro SIP Trunking Service. Claro SIP Trunking Service is a
SIP-based Voice over IP solution for customers ranging from small businesses to large
enterprises. It provides a flexible, cost-saving alternative to traditional hardwired telephony
trunks.

Claro SIP Trunking Service passed compliance testing with the observations/limitations outlined
in the scope of testing in Section 2.1 as well as under test results in Section 2.2.
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